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Preface 

 

This User Guide is been implemented by Boot & Work, S.L. working 

under the name Industrial Shields.  

 

Purpose of the manual 

The information contained in this manual can be used as a reference to operate and 
get a better understanding of the technical data of the signal modules, power supply 
modules and interface modules.  

Intended Audience 

This User Guide is intended for the following audience: 

• Persons in charge of introducing automation devices. 

• Persons who design automation systems. 

• Persons who install or connect automation devices. 

• Persons who manage working automation installation. 

 

 

   Warnings: 

 

• Unused pins should not be connected. Ignoring the directive may damage the 

controller. 

• Improper use of this product may severely damage the controller. 

• Refer to the controller’s User Guide regarding wiring considerations. 

• Before using this product, it is the responsibility of the user to read the product’s User 

Guide and all accompanying documentation. 

• Maintenance must be performed by qualified personnel familiarized with the 

construction, operation, and hazards involved with the control.  

•  Maintenance should be performed with the control out of operation and 

disconnected from all sources of power.  

• Care should be taken when servicing electrostatic sensitive components. The 

manufacturer's recommendations for these components should be followed.  

• The M-Duino LoRa Family PLCs are Open Type Controllers. It is required that you install 

the M-Duino PLC in a housing, cabinet, or electric control room. Entry to the housing, 

cabinet, or electric control room should be limited to authorized personnel. Failure to 
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follow these installation requirements could result in severe personal injury and/or 

property damage. Always follow these requirements when installing M-Duino LoRa 

Family PLCs. 

• In case of installation or maintenance of the M-Duino please follow the instructions 

marked in the Installation and Maintenance section. 

• Do not disconnect equipment when a flammable or combustible atmosphere is 

present. Disconnection of equipment when a flammable or combustible atmosphere is 

present may cause a fire or explosion which could result in death, serious injury and/or 

property damage. 

 

 

   Avertissements: 

 

• Les broches non utilisées ne doivent pas être connectées. Ignorer la directive peut 

endommager le contrôleur. 

• Une utilisation incorrecte de ce produit peut endommager gravement le contrôleur. 

• Reportez-vous au Guide de l’utilisateur du contrôleur pour les considérations de 

câblage. 

• Avant d’utiliser ce produit, il incombe à l’utilisateur de lire le Guide de l’utilisateur du 

produit et la documentation qui l’accompagne. 

• La maintenance doit être effectuée par personnel qualifié familiarisé avec la 

fabrication, le fonctionnement et les dangers liés au contrôleur. 

• La maintenance doit être effectuée avec l’équipement hors service et déconnectée de 

toutes les sources d'alimentation. 

• Faites attention lors de l'entretien des composants sensibles à l'électricité statique. 

Les recommandations du fabricant pour ces composants doivent être suivies. 

• Les automates de la famille M-Duino sont des contrôleurs de type ouvert. Il est 

nécessaire d'installer l'automate M-Duino dans un boîtier, une armoire ou une salle de 

contrôle électrique. L'accès au boîtier, à l'armoire ou à la salle de commande 

électrique doit être limité au personnel autorisé. Le non-respect de ces exigences 

d'installation peut entraîner des blessures graves et/ou des dommages matériels 

importants. Respectez toujours ces exigences lors de l'installation des automates de la 

famille M-Duino. 

• En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions 

indiquées dans la section Installation et Maintenance. 

• Ne débranchez pas l'équipement en présence d'une atmosphère inflammable ou 

combustible. La déconnexion de l'équipement en présence d'une atmosphère 

inflammable ou combustible peut provoquer un incendie ou une explosion pouvant 

entraîner la mort, des blessures graves et/ou des dommages matériels. 
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Application Considerations and Warranty 

Read and Understand this Manual 

Please read and understand this manual before using the product. Please consult your 

comments or questions to Industrial Shields before using the product. 

 

Application Consideration                               

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. 

THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR 

PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE 

NOT RATED OR DESSIGNED FOR SUCH PURPOSES.  

Please know and observe all prohibitions of use applicable to the products.  

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY 

WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED 

TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.  

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE 

PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE 

OVERALL EQUIPMENT OR SYSTEM.  

Industrial Shields shall not be responsible for conformity with any codes, regulations or 

standards that apply to the combination of products in the customer’s application or use 

of the product. 

The following are some examples of applications for which particular attention must be  

given. This is not intended to be an exhaustive list of all possible uses of the products, 

nor is it intended to imply that the uses may be suitable for the products: 

• Systems, machines, and equipment that could present a risk to life or property. 

• Nuclear energy control systems, combustion systems, railroad systems, 

aviation systems, medical equipment, amusement machines, vehicles, safety 

equipment, and installation subject to separate industry or government 

regulations. 

• WARNING: On outdoor operations, locations involving potential chemical 

contamination or electrical interference, conditions or uses not described in this 

document please contact Industrial Shields for further information. 

 

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party 

certification documents identifying ratings and limitations of use that apply to the 

products. This information by itself is not sufficient for a complete determination of the 

suitability of the products in combination with the system, machine, end product, or 

other application or use. 
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Disclaimers             

Weights and Dimensions 

Dimensions and weights are nominal and they are not used for manufacturing 

purposes, even when tolerances are shown. 

 

Performance Data 

The performance data given in this manual is provided as a guide for the user in 

determining suitability and does not constitute a warranty. It may represent the result of 

INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual 

application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS 

Warranty and Limitations of Liability. 

 

Change in Specifications 

Product specifications and accessories may be changed at any time based on 

improvements and other reasons. 

It is our practice to change model numbers when features are changed, or published 

ratings or when significant construction changes are made. However, some 

specifications of the products may be changed without any notice. When in doubt, 

special numbers may be assigned to fix or stablish key specifications for your 

application on your request. Please consult with your INDUSTRIAL SHIELDS 

representative at any time to confirm actual specifications of purchased products. 

 

Errors and Omissions 

The information in this document has been carefully checked and is believed to be 

accurate; however, no responsibility is assumed for clerical, typographical, or 

proofreading errors, or omissions. 
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Warranty and Limitations of Liability 

Warranty 

Industrial Shields’s exclusive warranty is that the products are free from defects in 

materials and workmanship for a period of one year (or other period if specified) from 

date of sale by Industrial Shields. 

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, 

EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-

INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS. 

ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE 

HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE 

REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS 

ALL OTHER WARRANTIES, EXPRESS OR IMPLIED. 

 

Limitations of Liability 

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, 

OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN 

ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS 

BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY. 

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY, 

REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL 

SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY 

HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO 

CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR 

REPAIR. 
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 General Description M-Duino 50RRA I/Os PLUS Product 

 

 Zone - Nomenclature 

The nomenclature shown in this point will be used in the whole User Guide, so it is 

important to understand this nomenclature. 

The nomenclature to differentiate the zones is based on the Alphabet, being A the 

shield from below and B the shield from above.  

  

 

 

 

 

 

 

• The inputs in the zone B are named I0.X, being X any number suitable in the 
Shield. Outputs are named as Q0.X and relays as R0.X 

• The inputs in the zone C are named I1.X, being X any number suitable in the 
Shield. Outputs are named as Q1.X and relays as R1.X 

• The inputs in the zone D are named I2.X, being X any number suitable in the 
Shield. Digital Outputs are named as Q2.X and Analog Outputs A2.X 
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 Zone Distribution 

 

 

The distribution of the different features that provide the M-Duino 50R I/Os PLUS is the 

following one: 

 

 

 

 

Shield B Zone C Zone D Zone 

 
 
 
 
 

Analog Shield 

  10 Inputs 
 (10 Digital Inputs, 

4 of which can work 
as Analog Input) 

 
 

4 Outputs  
(4 Digital Outputs) 

 
 
 
 
 

Relay Shield 

5 Inputs  
(5 Digital Inputs,  

4 of which can work 
as Analog Input)  

 
11 Outputs 

(8 Relay Outputs, 
 3 Digital Outputs,  

3 of which can work 
as Analog Output) 

 

6 Inputs  
(6 Digital Inputs,  

4 of which can work 
as Analog Input)  

 
11 Outputs 

(8 Relay Outputs, 
 3 Digital Outputs,  

3 of which can work 
as Analog Output)  
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 A Zone Features 

 

Shield A Zone 

Communication 
Shield 

(1x) Ethernet 

(1x) USB 

(1x) I2C 

(3x) TTL 

(1x) RS-232 

(1x) HALF/FULL Duplex RS-485 

(1x) SPI external Port 

(1x) RTC 

(1x) uSD Socket 

(1x) LoRa 

 

 

 

 Mechanical dimension 
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 General Features 

CONECTABLE PLC ARDUINO 24 VCC M-DUINO 

MODEL TYPE Controller General Specifications Information 

Input Voltage 12 to 24 Vdc 
Fuse Protection (2.5 A) Polarity 

protection 

I max. 1.5 A  

Size 101x119.3x119.5  

Clock Speed 16 MHz  

Flash Memory 256 KB of which 8 KB used by bootloader  

SRAM 8 KB  

EEPROM 4 KB  

Communications 
LoRa – I2C – Ethernet Port – USB – RS485 – RS232 – SPI 

– (2x) RX, TX (Arduino pins) 
MAX232 – MAX485 – W5500 – 

Sim800L 

USB Consideration! 
Only meant for uploading or debbuging, NOT ALWAYS 

connected as a serial in a project! 
Cannot be working in a final 

application 

An/Dig Input 10 bits 
(0-10 Vcc) 

0 to 10 V 
Input Impedance: 39K 

Separated PCB ground  
 

Digital Isolated Input 
(24 Vcc) 

5 to 24 Vdc 
I min: 2 to 12 mA 
Galvanic Isolation  

 

*Interrupt Isolated Input Hs 
(24 Vcc) 

5 to 24 Vdc 
I min: 2 to 12 mA 
Galvanic Isolation  

 

Analog Output 8 bits 
(0 – 10 Vcc) 

0 to 10 Vdc 
I max: 20 mA 

Sperated PCB Ground  
 

Digital Isolated Output 
(24 Vcc) 

5 to 24 Vdc 
I max: 70 mA 

Galvanic Isolation 
Diode Protected for Relay  

 
I max 24 Vdc: 410 mA 

Digital Isolated Output 
(Relay) 

24 VDC / 220 VAC 
I max: 5 A 

Galvanic  Isoltation 
Diode Protected for Relay  
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PWM Isolated Output 8 bits 
(24 Vcc) 

5 to 24 Vdc 
I max: 70 mA 

Galvanic Isolation 
Diode Protected for Relay  

 

Expandability 
I2C – 127 elements – Serial Port RS232 / RS485 / 

LoRa 
 

*By using this type of signal can no longer use Digital signal (24 Vdc) 
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 Technical Specifications: 

 General Specifications:  

Item M-Duino PLC Arduino Ethernet & LoRa 58 I/Os Analog/Digital PLUS 

Power supply 
voltage 

DC power supply 12 to 24Vdc  

Operating 
voltage range 

DC power supply 11.4 to 25.4Vdc 

Power 
consumption 

DC power supply 30VAC max. 

External 
power supply 

Power supply 
voltage 

24Vdc 

Power supply 
output capacity 

700Ma 

Insulation resistance 20MΩ min.at 500Vdc between the AC terminals and the protective earth terminal. 

Dielectric strength 
2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the 
external AC terminals and the protective ground terminal. 

Shock resistance 80m/s2 in the X, Y and Z direction 2 times each. 

Ambient temperature (operating) 0º to 60ºC 

Ambient humidity (operating) 10% to 90% (no condensation) 

Ambient environment (operating) With no corrosive gas 

Ambient temperature (storage) -20º to 60ºC 

Power supply holding time 2ms min. 

Weight 599g max. 
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 Performance Specification: 

Arduino Board ARDUINO MEGA 2560 

Control method Stored program method 

I/O control method Combination of the cyclic scan and immediate refresh processing methods. 

Programming language 
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a 
programming language. “similar to the C”.  http://arduino.cc/en/Tutorial/HomePage 

Microcontroller ATmega2560 

Flash Memory 256KB of which 8KB are used by the bootloader 

Program capacity (SRAM) 8KB 

EEPROM 4KB 

Clock Speed 16MHz 

Clock Speed 16MHz 

 

 Symbology 

Table that includes all the symbology that is used in the serigraph of the M-Duino PLC Arduino 

Ethernet & LoRa 58 I/Os Analog/Digital PLUS: 

Symbol 
 

Standard No. / 
Standard Title 

 

Standard 
Reference No. / 

Symbol Title 
Symbol Meaning 

 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

5031 / Direct 
Current 

Indicates that the equipment is 
suitable for direct current only; 
to identify relevant terminals 

 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

 

5032 / Alternating 
Current 

Indicates that the equipment is 
suitable for alternating current 

only; to identify relevant 
terminals 

 

 
IEC 60417 / 

Graphical symbols 
for use on 
equipment 

 

5130 / Pulse 
General 

To identify the control by 
which a pulse is started. 

 

 IEC 60417 / 
Graphical symbols 

for use on 
equipment 

 

5017 / Earth, 
Ground 

To identify an earth (ground) 
terminal in cases where 

neither the symbol 5018 nor 
5019 is explicily required. 

 

 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

 

5115 / SIgnal lamp 

To identify the switch by 
means of which the signal 

lamp(s) is (are) switched on or 
off. 

http://arduino.cc/en/Tutorial/HomePage
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Medical Devices 
Directive 

93/42/EEC 
CE Marking 

CE marking indicates that a 
product complies with 

applicable European Union 
regulations 

 
 

ISO 7000/ 
Graphical symbols 

for use on 
equipment 

 

0434B / 
Warning symbol 

Indicates a potentially 
hazardous situation which, if 
not avoided, could result in 

death or serious injury 

 
ISO 7000/ 

Graphical symbols 
for use on 
equipment 

 

5036 / Dangerous 
Voltage 

To indicate hazards arising 
from dangerous voltages 

 

 Precautions 

Read this manual before attempting to use the ETHERNET & LORA 50RRA I/Os 

ANALOG/DIGITAL PLUS PLC and follow its descriptions for reference during operation. 

 Arduino Board 

The MDUINO PLC ARDUINO ETHERNET & LORA 50RRA I/Os ANALOG/DIGITAL PLUS includes an 

Arduino Mega Board as controller. 

 Intended Audience 

This manual is intended for technicians, which must have knowledge on electrical systems. 

 General Precautions 

The user must operate M-Duino according to the performance specifications described in this 

manual. 

Before using the M-DUINO PLC ARDUINO ETHERNET & LORA 50RRA I/Os ANALOG / DIGITAL 

PLUS under different conditions from what has been specified in this manual or integrating 

into nuclear control systems, railroad systems, aviation systems, vehicles, combustion systems, 

medical equipment, amusement machines, safety equipment and other systems, machines, 

and equipment that may have a serious influence on lives and property if used improperly, 

consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance 

characteristics of the M-Duino are sufficient for the systems, machines, and equipment, and be 

sure to provide the systems, machines, and equipment double safety mechanisms. This 

manual provides information for programming and operating the M-DUINO. 
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 Software interface 

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C 

language. They can also be programmed using directly C, but it is much easier working with 

Arduino IDE as it provides lots of libraries that helps in the programming.   

Industrial Shields provides boards for programming the PLCs much easier. Basically, it is no 

needed to define the pins and if that pins are inputs or outputs. Everything is set up 

automatically if using the boards. 

In order to install Industrial Shields boards, these are the steps that must be followed. 

Requirements: 

Arduino IDE 1.8.0 or above (better to have always the latest version). 

Steps: 

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. In Additional Boards Manager URLs write the following: 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json 

3. Press OK to save the changes. 

 

 

 

 

 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json


Ref. 004002001100  Rev. 0: 27-08-2020 

19 
 

4. Go to: Tools -> Board: … -> Boards Manager 

 

 

 

5. Search for “industrialshields” on the browser. 
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6. Click install (selecting the latest version). 

Following these steps, you will be able to see now the Industrial Shields Boards: 

 

Once it is selected the family, an extra option will appear on Tools: 

There, it can be selected the exact model for every family.  

 

 

Also, there are some examples of programming in File -> Examples -> M-Duino LoRa Family. 

Furthermore, there are some extra libraries that can be found in Industrial Shields GitHub. 

https://github.com/IndustrialShields/ 

 

https://github.com/IndustrialShields/
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 How to connect PLC Arduino to PC 

- Connect USB port from PLC to PC.  

NOTE:  
M-Duino LoRa Family uses USB-B cable.  

 
 
 

- Open Arduino IDE interface: 
 

- Select Industrial Shields boards -> M-Duino LoRa Family 
 

 
 

- Select the correct M-Duino Board(M-Duino 50ARR+ LoRa). 
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- Select correct port.  

 

 
 

 How to connect PLC to power supply 

- M-Duino LoRa Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT 

REVERSAL!  

- Make sure that the live and GND connector of the power supply match the PLC. 

- Make sure that the power supply mains output is not higher than 24Vdc. 

 

  

- Suggested power suppliers

 

Compact DIN rail power supply. Assembled on 35mm 

DIN Rail: 

-12Vdc / 24Vdc 

-2.5A 

-30W 

 

Industrial Shields power supplies provide parallel 

operation, overvoltage protection, and overcurrent 

protection. There is a LED inductor for power status, 

the power supply is certified according to UL. 
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The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types 

of electrical devices and their accessories, regardless of where use of the device is intended.  

The equipment must be powered from an external power source in accordance with IEC 

61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-

1. 

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of 

the equipment must be separated from the dangerous voltage cables 

 

 M-Duino LoRa Family Pinout 

 A Zone connection 

 

 

 

 

 

 

 

 

 

 

 

 

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select 

pin of any device. 
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AREF 
IOREF2 
IOREF1 

7Vdc 
GND 

3.3Vdc 
GND 
5Vdc 
GND 
SCL 
SDA 
RX0 
TX0 
RX1 
TX1 
TX 
RX 
Z- 
Y+ 
B- 
A+ 

PIN3 
50 SO 
51 SI 

52 SCK 
Reset 
Vin5 
NC 

GND 
GND 

24Vdc 

AREF 
IOREF2 
IOREF1 

7Vdc 
GND 

3.3Vdc 
GND 
5Vdc 
GND 
21 
20 
1 
0 

19 
18 
16 
17 
- 
- 
- 
- 
3 

50 
51 
52 

Reset 

Vin5 
- 
- 
- 
- 

Arduino PIN 
Arduino PIN 
Arduino PIN 

- 
GND 

Arduino PIN 
GND 

- 
GND 

I2C/SS 
I2C/SS 
RX0/SS 
TX0/SS 
RX1/SS 
TX1/SS 

RX2(serial 2) 
TX2(serial 2) 

RS485 
RS485 
RS485 
RS485 

Arduino Pin 
SPI 
SPI 
SPI 
SPI 
5V 

Not Connected 
Gnd 
Gnd 

Power Supply 

 
 
 
Configuration Switch* (see section 8 for 
configuring the communications. 
Enabling communications disables some 
I/Os) 
 
 
 
Communication Pins  
 
 
 
 
 
 
 
 
 
Power supply connectors  
(24Vdc – GND) 
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*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using 

serial communication. When uploading code to Arduino Mega set switch to ON.  

 

 

 

 

 

Ethernet            Arduino                                               Power 
Connector         Reset button        
                                                            USB programmer                         Autoreset 
          connector   
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 B Zone (Relay Shield)  

  

 

  

 

 

 

 

 

 

   

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 See section 8 to select suitable switch configuration for enable these connections. 

B Zone 

M
-D

u
in

o
 

C
o

n
n

e
c
to

r 

A
rd

u
in

o
 P

in
 

F
u

n
c
ti
o

n
  

R0.8 
R0.7 
R0.6 
R0.5 
R0.4 
A0.21 
A0.11 
A0.01 
GND 
Q0.21 
Q0.11 
Q0.01 

GNDCOM 
24VCOM 

37 
38 

39 
40 
24 
6 
5 
4 

GND 
6 
5 
4 
- 
- 

Relay Out 
Relay Out 
Relay Out 
Relay Out 
Relay Out 
Analog Out 
Analog Out 
Analog Out 

GND  
Digital/PWM Out 
Digital/PWM Out 
Digital/PWM Out 

External Isolated Out Gnd 
External Isolated Out Vdc 

 

B Zone 

M
-D

u
in

o
 

C
o

n
n

e
c
to

r 

 

A
rd

u
in

o
 P

in
 

    

F
u

n
c
ti
o

n
  

R0.3 
R0.2 
R0.1 
GND 
I0.5 
I0.4 
I0.3 
I0.2 
I0.11 

(-)I0.1 
NC 
NC 

25 
22 

23  
GND  
57 
56 
55 
54 
3 
- 
- 
- 

Relay Out 
Relay Out 
Relay Out 

GND 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 

Interrupt 1 In 
GND I0.1 

Not Connected 
Not Connected 

Top Zone 

Led indicator I/Os state 

 
 
 
 
Relay Outputs 
 
 
 
 
 
 
 
Analog Outputs (Switch 
Configuration) 
 
Digital/PWM Outputs 
(isolated)  
 

 

 
 
 
Relay Outputs 
 
 
 
 
 
 
 
 
Analog/Digital Inputs 
 
Interrupt Inputs (isolated) 
 
Configuration Switch 
(see section 8 to select the 
correct configuration for 
outputs). 
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7.3 C Zone (Relay Shield) 

 

 

  

 

 

 

 

 

 

   

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

See section 8 to select suitable switch configuration for enable these connections. 

C Zone 

M
-D

u
in

o
 

C
o

n
n

e
c
to

r 

A
rd

u
in

o
 P

in
 

F
u

n
c
ti
o

n
  

R1.8 
R1.7 
R1.6 
R1.5 
R1.4 
A1.21 
A1.11 
A1.01 
GND 
Q1.21 
Q1.11 
Q1.01 

GNDCOM 
24VCOM 

42 
43 
44 
45 
29 
11 
10 
8 

GND 
11 
10 
8 

- 
- 

Relay Out 
Relay Out 
Relay Out 
Relay Out 
Relay Out 
Analog Out 
Analog Out 
Analog Out 

GND  
Digital/PWM Out 
Digital/PWM Out 
Digital/PWM Out 

External Isolated Out GND 
External Isolated Out Vdc 

 

C Zone 

M
-D

u
in

o
 

C
o

n
n

e
c
to

r 

 

A
rd

u
in

o
 P

in
 

    

F
u

n
c
ti
o

n
  

R1.3 
R1.2 
R1.1 
GND 
I1.5 
I1.4 
I1.3 
I1.2 
I1.11 

(-)I1.1 
I1.01 

(-)I1.0  

30 
27 
28  

GND  
63 
62 
61 
60 
19 
- 

18 
- 

 

Relay Out 
Relay Out 
Relay Out 

GND 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 

Interrupt 1 In 
GND I0.1 

Interrupt 0 In 
GND I0.0 

 

. 
 
 
RELAY Outputs 
 
 
 
 
 
 
 
 
Analog/Digital Inputs 
 
Interrupt Inputs (isolated) 
 
 
Configuration Switch 
(see section 8 to select correct 
configuration for outputs). 
 

Top Zone 

Led indicator I/Os state 

 
 
 
 
Relay Outputs 
 
 
 
 
 
 
 
 
Analog Output (Switch 
Configuration) 
 
Digital/PWM Outputs 
(isolated)  
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7.4 D Zone (Analog Shield)  

 

 

  

 

 

 

 

 

 

   

  

 

 

 

 

 

  

 

 

 

 

 

 

 

 See section 8 to select suitable switch configuration for enable these connections. 

 

D Zone 

M
-D

u
in

o
 

C
o

n
n

e
c
to

r 

A
rd

u
in

o
 P

in
 

F
u

n
c
ti
o

n
  

NC 
NC 

I2.10 
I2.9 
I2.8 
I2.7 

(-)I2.6/INT1 
I2.6/INT11 

(-)I2.5/INT0 
I2.5/INT01 

NC 
NC 

(-)I2.3 
I2.3 

(-)I2.2 
I2.2 

(-)I2.1 
I2.1 

(-)I2.0 
I2.0 

- 
- 

69 
68 

67 
66 
- 

21 
- 

20 
- 
- 
- 

35 
- 

34 
- 

33 
- 

32 

Not Connected 
Not Connected 

Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 
Analog/ Digital  In 

GND I2.6 
Interrupt 1 In 

GND I2.5 
Interrupt 0 In 

Not Connected 
Not Connected 

GND I2.3 
Digital Input 
GND I2.2 

Digital Input 
GND I2.1 

Digital Input 
GND I2.0 

Digital Input 

D Zone 

M
-D

u
in

o
 

C
o

n
n

e
c
to

r 

 

A
rd

u
in

o
 P

in
 

    

F
u

n
c
ti
o

n
  

NC 
NC 
NC 
NC 

Q/Vdc 
COM(-) 

NC 
NC 
NC 
NC 

Q2.3 
Q2.2 
Q2.1 
Q2.0 

- 
- 
-  
- 
- 
- 
- 
- 
- 
- 

49 
48 
47 
53 

Not Connected 
Not Connected 
Not Connected 
Not Connected 

External Isolated Out Vdc 
External Isolated Out GND 

Not Connected 
Not Connected 
Not Connected 
Not Connected 

Digital Out 
Digital Out 
Digital Out 
Digital Out 

 
 
 
Analog/Digital Inputs 
 
 
 
Interrupt Inputs (isolated) 
 
 
 
 
Digital Inputs (isolated)  
 

 

Configuration Switch*  
(see section 8 to select the  correct 
configuration for outputs). 
 
 
 
 
 
 
 
 
 
Voltage Supply/Reference for 
Digital/PWM Outputs (isolated) 
 
 
 
PWM/Digital Outputs 

Led indicator I/Os state 

Top Zone 
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 Switch Configuration 

 A Zone: Communications  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. SCL/I2.6: Choosing between SCL or the input I2.6. If this switch is ON, it enables the I2.6    

input and disables the SCL. If this switch is OFF, it enables SCL and disables I2.6.  

3. SDA/I2.5: Choosing between SDA or the input I2.5. If this switch is ON, it enables the I2.5    

input and disables the SDA. If this switch is OFF, it enables SDA and disables I2.5.  

2. RX1/I1.1: Choosing between RX1 or the input I1.6. If this switch is ON, it enables the I1.6 
input and disables the RX1. If this switch is OFF, it enables RX1 and disables I1.6. 
 
1. TX1/I1.0:  Choosing between TX1 or the input I1.5. If this switch is ON, it enables the I1.5 
input and disables the TX1. If this switch is OFF, it enables TX1 and disables I1.5. 

 

LEFT ZONE 

Switch  

 ON OFF 

D ZONE 

SCL/I2.6 I2.6 SCL 

SDA/I2.5 I2.5 SDA 

C ZONE 

RX1/I1.1 I1.1 RX1 

TX1/I1.0 I1.0 TX1 

B ZONE 

Pin 3/I0.1 I0.1 Pin 3 

LoRa/NC NC LoRa 

uSD & RS-485 

D53(SD)/Q2.0 Q2.0 SD 

FD RS-485 HD HD FD 
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4. Pin 3/I0.1:  Choosing between Pin 3 or the input I0.1. If this switch is ON, it enables the I0.1 
input and disables the Pin 3. If this switch is OFF, it enables Pin 3 and disables I0.1. 

 
3. LoRa/NC: ALWAYS AT OFF POSITION! Switch has to be OFF position to enable the LoRa 
communication, never ON because in this position is NC (Not Connected). 

 
2. D53(SD)/Q2.0: Choosing between the Chip Select of the microSD or the output Q2.0. If this 
switch is ON, it enables the Q2.0 and disables the microSD. If this switch is OFF, it enables the 
microSD and disables the Q2.0.  

 
1. FD RS-485 HD:  Choosing between FD or HF. If this switch is ON, it enables the Half Duplex 
(HD) option and disables the FD. If this switch is OFF, it enables Full Duplex (FD) and disables 
HD. 
 

 

 

 

 

 

1. RTC SDA: This switch enables the communication to communicate with the RTC 

using I2C. Having this switch in ON mode it actives this communication, 

whereas if it is in OFF mode it disables the I2C to reach the RTC.  

 

2. RTC SCL: This switch enables the communication to communicate with the RTC 

using I2C. Having this switch in ON mode it actives this communication, 

whereas if it is in OFF mode it disables the I2C to reach the RTC.  

 

3. NC: Not connected. This switch is not connected to anything, it doesn’t matter 

if it is in ON mode or OFF mode. 

 

4. NC: Not connected. This switch is not connected to anything, it doesn’t matter 

if it is in ON mode or OFF mode. 

 

 

 

 

 

LEFT ZONE 

SWITCH ON OFF 

NC - - 

NC - - 

RTC SCL RTC - 

RTC SDA RTC - 



Ref. 004002001100  Rev. 0: 27-08-2020 

30 
 

 B Zone Switches 

 

 

 

 

 

 

 

 

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it 

can only act as an Analog Output. 

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide 

this digital output is represented with Q0.X, being X any number of the tables above.  

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide 

this analog output is represented with A0.X, being X any number of the tables above.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

B ZONE 

SWITCH ON OFF 

NC - - 

Q0.2 Q0.2 A0.2 

Q0.1 Q0.1 A0.1 

Q0.0 Q0.0 A0.0 
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8.3 C Zone Switches 

 

 

 

 

 

 

 

 

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it 

can only act as an Analog Output. 

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide 

this digital output is represented with Q1.X, being X any number of the tables above.  

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide 

this analog output is represented with A1.X, being X any number of the tables above.   

 

 

 

 

 

 

 

 

 

 

 

 

 

C ZONE 

SWITCH ON OFF 

NC - - 

Q1.7 Q1.2 A1.2 

Q1.6 Q1.1 A1.1 

Q1.5 Q1.0 A1.0 
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8.4 D Zone Switches 

All the options on this switch are Not Connected. 
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 M-Duino Arduino I/Os 5V pins 

The MDUINO PLC ARDUINO ETHERNET & LORA 50RRA I/Os ANALOG/DIGITAL PLUS has some 

of the Mega board pins available.  These pins can be programmed according to Arduino 

features such as I/Os operating at 5V or any additional features present in the pins (for 

example I2C communication in pins SCL and SDA). As these pins are directly connected to the 

Arduino Mega board they are not as well protect as the normal inputs. These pins are mainly 

meant to be used as prototyping. 

The Arduino board available pins are summarized in the table below. In order to access some 

of these pins the configuration switch must be set to OFF position (see section 8) and some 

extra considerations must be taken in consideration when using these pins. 

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V. 

These terminals provide direct access to the Mega board. 

Apart from the switch configuration there are some special conditions depending on these 5V. 

Now it is going to be shown the considerations to operate with these pins. 

 I2C pins – SDA/SCL 

The I2C protocol is meant to work in a pull-up configuration. A pull-up configuration means 

that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case 

it reads 5V when nothing is connected. The pull-up configuration is stablished by default in 

these pins. 

 If it is meant to work them as a GPIO at 5V, it has to be considered that they are pull-up 

inputs. 

*IMPORTANT: I2.5 & I2.6 are not pull-up inputs although they are referred to the I2C pins 

(switch configuration). There is a “reverse pull-up circuit “that is stablished in order to have the 

same behaviour as the other inputs.  

 Serial 0 – RX0/TX0 

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in 

case that all the 5V pins are already performing a function. This is because they are shared 

with the USB interface. If using these pins, the USB communication cannot be working at the 

same time. When the PLC is not installed, the USB communication is normally required for 

M-Duino terminal Arduino pin Enable Arduino pin 

SCL 21 Communication switch: OFF 

SDA 20 Communication switch OFF 

RX0 0  

TX0 1  

RX1 19 Communication switch OFF 

TX1 18 Communication switch OFF 

MISO 50  

MOSI 51  

SCK 52  

Pin 3 3 Communication switch: OFF 
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debugging, uploading and intercommunicating with the Ethernet controller. If using both 

interfaces at the same time the Arduino board will get blocked.  

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not, it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 

 Serial 1 – RX1/TX1 

These pins are only referred to the inputs I1.5/I1.6. If the switch configuration is in OFF 
position the pins RX1/TX1 will be available. If not using the Serial 1 interface these pins can 
work as digital, either input or output.  
 
These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 

 SPI – MISO/MOSI/SCK 

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the 

Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours 

cannot happen at the same time as the Ethernet would not work. 

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 

 Pin 3 

This pin is only referred to the input I0.6. If the switch configuration is in OFF position the Pin 3 

will be available. 

This pin is not stablished with a pull-up or a pull-down configuration. The state of this pin is 

unknown. If this pin must be used, it requires a pull-up or a pull-down configuration. The 

Arduino board allows the pin to be set in a pull-up configuration. If not, it must be stablished 

an external pull-up or pull-down circuit in order to correctly work with this pin. 
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 A Zone Features: Communications & RTC & uSD 

 RS-232 

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16 

and 17 of the Arduino Mega).  

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not 

matter the configuration of the switches to implement a RS-232 communication. 

Using the boards of Industrial Shields, there is a library that simplifies the RS-232 

implementation. 

 RS-485 

For RS485 communication protocol the defined Arduino Mega pins are showed in the chart 

below.  

Function Arduino Pin 

DI 14 

RO 15 

RE 11 

DE 46 

 

For the RS-485 communication protocol there is only one switch that affects in this 

communication. The RS-485 protocol will be always enabled, the only switch that affects is the 

one called “FD rs-485 HD” (See Section 8). This switch makes the choosing between RS-485 

Half Duplex or RS-485 Full Duplex (RS-422). 

Using the boards of Industrial Shields, there is a library that simplifies the RS-485 

implementation. 

 I2C 

I2C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino LoRa Family. The 

pull-up resistor is already implemented in the PCB.  

I2C communication is configured by switches, so the switches must be configured in order to 

enable the I2C communication. 

 

 

 

 

To enable I2C the switches SCL/I2.6(I2.1) & SDA/I2.5(I2.0) must be set to OFF mode. In this 

mode the inputs are totally disabled and the I2C is now enabled. 

Switch  

 ON OFF 

D ZONE 

SCL/I2.6 I2.6 SCL 

SDA/I2.5 I2.5 SDA 
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Industrial Shields does not provide any library to implement the I2C as it can be used the 

standard library of Arduino called Wire. 

 SPI 

The M-Duino pins used for the SPI bus are summarized in the table below. For SPI bus MISO, 

MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely, 

each of the connected devices will have a single and dedicated SS pin.  

Function M-Duino connection Mega board pin 

MISO 50 S0 50 

MOSI 51 SI 51 

CLOCK 52 SCK 52 

Reset Reset Reset 

SS SCL/SDA/RX0/TX0/RX1/TX1/RX3/TX3/Pin3 21/20/1/0/19/18/15/14/3 

Check the switch configuration at section 8 to enable SS pins. 

 TTL 

M-Duino has two TTL ports, RX0/TX0, RX1/TX1. TTL0 is accessed with the function Serial (pins 0 

and 1 of the Arduino Mega). TTL1 is accessed with the function Serial1 (pins 18 and 19 of the 

Arduino Mega). 

In order to use the TTL pins the configuration of the switches have to be the following one: 

 

 

 

 

If the switches RX1/I1.1 & TX1/I1.0 are in OFF mode, the RX1/TX1 will be enabled. In order to 

use TTL3 these switches must be in OFF mode. 

 

 

 

 

 

 

 

 

Switch  

 ON OFF 

C ZONE 

RX1/I1.6 I1.1 RX1 

TX1/I1.5 I1.0 TX1 
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 LoRa 

M-Duino LoRa port controller is based on RFM95C. In the M-Duino, RFM95C controller 

communicates to the Mega board via SPI bus (Reset is Arduino Mega pin 2, SS is Arduino Mega 

pin 12, interruption is Arduino Mega pin 13). 

Also, there are some examples of programming in File -> Examples -> LoRa. 

 

 

 Ethernet 

M-Duino Ethernet port controller is based on w5500 IC, which is the compatible IC compatible 

with Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible 

with the M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS 

Arduino Mega pin 10).  

 

 RTC 

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the I2C protocol 

communication, so it is required to have enabled the I2C protocol.  

4 switches have to be configured in order to enable the RTC features: 

 

RTC SCL & RTC SDA must be set to ON mode to enable 

the I2C wires to the RTC. If they are in OFF mode, the 

Arduino will not communicate with the RTC. 

I2C must be enabled in order to communicate with the 

LEFT ZONE 

SWITCH ON OFF 

NC - - 

NC - - 

RTC SCL RTC - 

RTC SDA RTC - 
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RTC. See section 11 I2C to enable it. 

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation 

called RTC. 

 

 uSD 

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol 

is always enabled, as there are no switches that configure it. However, there is a switch that 

must be placed to ON mode in order to communicate with the uSD: 

D53(SD): If this Switch is OFF, it enables the Chip Select of the microSD socket and disables 

Q2.0. If this switch is ON, it enables the Q2.0 output. If the switch is in ON mode the microSD 

can’t be used. 

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of 

the PLC, it is required to open the plastic found in the frontal part and the socket is located 

under the supply of the Arduino. 

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation 

called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to 

select the Chip Select of the uSD chip.  

 

  Verify that the CPU is not actively running a process before inserting the memory card.  

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the 

operation of an online process or machine. Unexpected operation of a process or machine 

could result in death or injury to personnel and/or property damage. Before inserting a 

memory card, always ensure that the CPU is offline and in a safe state. 

 

  Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la 

carte mémoire. 

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le 

fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un 

processus ou d'une machine peut entraîner la mort ou des blessures corporelles et / ou des 

dégâts matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est 

hors ligne et en sécurité. 
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 Instructions for interconnection between Industrial Shields 

controllers 

 

 RS-232 Communication: 

 

 RS-485 Communication: 

11.2.1.1 Half Duplex  

 

 

 

11.2.2 Full Duplex 
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 Ethernet 

 

 

For an Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet 

crossover cable must be used. 
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 I/O technical details:  

 

Digital Output Waveform: 

 

 

 

 

 

 

 

Digital Out-put Turn-off: 

 

PWM Waveform:  

 

 



Ref. 004002001100  Rev. 0: 27-08-2020 

42 
 

Analog Out Turn On: 

 

Analog Out Turn-Off: 

 

Analog /Digital input Turn-on: 
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 Typical Connections 
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 Connector details: 

  

The connector inside the PLCs that mounts on the PCB is  MC 0,5/10-G-2,5 THT – 1963502 

from Phoenix contact. MC0,5/10-G-2,5THT  

For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix 

contact. FK-MC 0,5/10-ST-2,5 

 

Connection details: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Article reference MC 0,5/10-G-2,5 THT 

Height 8,1mm 

Pitch 2,5mm 

Dimension 22,5mm 

Pin dimensions 0,8x0,8mm 

Pin spacing 2,50mm 

Article reference FK-MC 0,5/10-ST-2,5 

Rigid conduit section min. 0,14 mm² 

Rigid conduit section max. 0,5 mm² 

Flexible conduit section min. 0,14 mm² 

Flexible conduit section max. 0,5 mm² 

Conduit section AWG/kcmil min. 26 

Conduit section AWG/kcmil max. 20 

https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1881406&library=usen&tab=1#General
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 Mechanical Characteristics 

 

- Dimension : 

 

 

 

 

 

 

 

 
 

- DIN Rail mounting 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
For optimal operation of the product, it must be located in an electrical cabinet with IK08 

mechanical protection. The minimum IP protection degree required is IP56. 
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 Installation and Maintenance 

 
 
Notes for installation: 
 

- The installation position should be free from the following: dust or oil smoke, 
conductive dust, corrosive or flammable gas, high temperature, condensation, and 
rain.  

- Besides, vibration and impact also affect the PLC normal operation and shorten its 
lifespan; electric shock, fire or misact also damages the product. During drilling or 
wiring, prevent the metal particles or wire segments from falling into the PLC casing, 
which may cause fire, fault or misact.  

- After the PLC installation, clean the ventilation duct to prevent blocking, which may 
cause bad ventilation, or even fire, faults or misact.  

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or 
damage the circuit. Installation and wire connection must be firm and reliable. Poor 
connection could cause misact.  

- Use shielded twisted pair for the I/O of high frequency signal and analog signal to 
improve system IMS. 

 
The installation environment should be free from dust, oil smoke, conductive particle, 
corrosive or flammable gases, high temperature, condensation, and rain.  
 
Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan. 
It is recommended to install the PLC, together with the matching switches and contactors, 
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high 
ambient temperature or heat generating equipment nearby, install forced convection 
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring, 
prevent the metal particles or wire segments from falling into the PLC casing, which may 
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent 
blocking, which may cause bad ventilation, or even fire, faults or misact. 
 
The only way to disconnect the equipment from the electrical network is by removing the 
connectors that feed the equipment. Once installed in the electrical cabinet it is very 
important to ensure the power connectors for proper operation. 
 
 

Separate the M-Duino 50RRA I/Os PLUS from heat, high voltage and electrical noise: 
 
 
Always separate the devices that generate high voltage and high electrical noise from the 
M-Duino 50RRA I/Os PLUS. When configuring the layout of the M-Duino 50RRA I/Os PLUS 
inside your panel, consider the heat-generating devices and locate the electronic-type 
devices in the cooler areas of your cabinet. Reducing the exposure to a high-temperature 
environment will extend the operating life of any electronic device. Consider also the 
routing of the wiring for the devices in the electric cabinet. Avoid placing low-voltage 
signal wires and communications cables in the same tray with AC power wiring and high-
energy, rapidly-switched DC wiring.  
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Provide adequate clearance for cooling and wiring M-Duino 50RRA  I/Os PLUS. Is designed 
for natural convection cooling. For proper cooling, you must provide a clearance of at least 
25 cm above and below the devices. Also, allow at least 25 cm of depth between the front 
of the modules and the inside of the enclosure. 
 

Notes for maintenance: 
 
A well-planned and executed maintenance program is essential to the satisfactory operation of 
solid-state electrical equipment. The kind and frequency of the maintenance operation will 
vary with the kind and complexity of the equipment as well as with the nature of the operating 
conditions. Maintenance recommendations of the manufacturer or appropriate product 
standards should be followed. 
 
The following factors should be considered when formulating a maintenance program:  
 

- Maintenance must be performed by qualified personnel familiar with the construction, 
operation, and hazards involved with the control.  

-  Maintenance should be performed with the control out of operation and 
disconnected from all sources of power.  

- Care should be taken when servicing electrostatic sensitive components. The 
manufacturer's recommendations for these components should be followed.  

- Ventilation passages should be kept open. If the equipment depends upon auxiliary 
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when 
necessary) should be made of these systems.  

- The means employed for grounding or insulating the equipment from ground should 
be checked to assure its integrity. 

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks, 
should be removed according to the manufacturer's instructions, if provided; 
otherwise, the manufacturer should be consulted. Care must be taken to avoid 
damaging any delicate components and to avoid displacing dust, dirt, or debris in a 
way that permits it to enter or settle into parts of the control equipment. 

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and 
dirt should be removed from the top of the enclosures before opening doors or 
removing covers.  

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g., 
polychlorinated biphenyls (PCBs) found in some liquid-filled capacitors) must be 
disposed of as described in Federal regulations. 

 
Safety rules for maintenance personnel 
 

Consider the following steps to follow. A false manoeuvre could be the cause of an 
accident or material damage. 
Do not disassemble or modify the modules. This could lead to breakdowns or 
malfunctions and could lead to injuries or fire. 

 
- All types of radio communication devices, including mobile phones and personal 
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all 
directions. Failure to observe this precaution exposes malfunctions caused by excess of 
temperature. 
- Disconnect the external power supply of the system (on all phases) before connecting 
or disconnecting a module. Failure to observe this precaution may cause faults or 
malfunctions of the module. 
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- Tighten the screws of the terminal ports and the screws of the connectors within the 
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires 
and cause malfunctions. Excessive tightening can damage the screws and / or the 
module, with the risk of falling, short circuits and malfunctions. 
- Before handling a module, dispose of the electrostatic charge accumulated by the 
human body by touching a suitable conductive object. Failure to observe this 
precaution may cause faults or malfunctions of the module. 

 
Repair note: 
 

If the equipment is suitable to be repaired, it must be verified that the equipment 
remains in a safe state after repair. 
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 Revision Table 

 
 

Revision Number Date Changes 

0 27/08/2020 First implementation 
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About Industrial Shields: 
 
Direction: Fàbrica del Pont, 1-11 

Zip/Postal Code: 08272  

City: Sant Fruitós de Bages (Barcelona)  

Country: Spain 

Telephone: (+34) 938 760 191 / (+34) 635 693 611 

Mail: industrialshields@industrialshields.com 

mailto:industrialshields@industrialshields.com

